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Exam A 

QUESTION 1 

What best describes a theme for an XPage application? 

A. A theme is a collection of JavaScript resource files that are used to implement the user interface. 

B. All of the above can be included in themes. 

C. A theme is a collection of Dojo modules that are used for the XPages application. 

D. A theme is a collection of CSS files. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 2 Linda would like to have a navigator pane for her 

XPages application. 

What would be the best way to implement this pane? 

A. She has to build the navigator by using a Notes view with documents defining each link in her navigator. She then integrates that view in each XPage that her application needs. 

B. She puts the links for her navigation together by building a custom control and can use that for every page that she needs. 

C. She downloads and installs a JavaScript library for a menu. 

D. Unfortunately, there is no simple way to do it. so she has to build it on every XPage. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 3 

Barney imports a WSDL file into a LotusScript script library, which generates code to call the Web service methods defined by the WSDL file. 

Where can he use this script library? 

A. Anywhere that LotusScript can be used 

B. Only in agents 

C. Only in agents and form or view actions 

D. Only in agents that run on the server 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 4 

Nancy is creating a Web application and she needs anonymous users to be able to read content and create certain documents. 

What does Nancy need to do? 

A. Nancy needs to create an Anonymous entry to the ACL with access set to Author. Then, using @Formula she needs to validate if a document is being created by an Anonymous user. 
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B. Nancy needs to create an Anonymous entry to the ACL with access set to reader and the option “Write public documents”. She also needs to make the forms Available to Public Access users. 

C. Anonymous must be set to Author in the ACL and forms must be blocked to Anonymous users. 

D. Anonymous users cannot create documents if the ACL is set to Reader. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 5 Joy wants to implement single sign-on for her Lotus Domino 

Web applications. 

What does she need to do? 

A. Ensure that all servers are using the same certificate authority. 

B. Enable “use Single Sign-on” in the database properties. 

C. Encode the Single Sign-On form in each database. 

D. Update the “Session authentication” field in the server’s configuration document. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 6 

Marge wants to track user preference information while users navigate through her Web site, but does not want to require users to authenticate when accessing the site. 

Which of the following should she use to track the user information? 

A. The users must authenticate 

B. Servlets 

C. User profile documents 

D. Cookies 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 7 Adele would like to include a style sheet in every page of 

her application. 

What should she do to accomplish this? 

A. Create a theme and define the style resource within the theme. 

B. Create a style resource and reference it in each design element. 

C. Create a theme defining the style resource and turn on the Enable Enhanced HTML Application options in the application properties. 

D. Use the Enable Enhanced HTML Application option in the application properties, and select her style sheet as the Default Style Sheet Application property. 

Correct Answer: C 

Section: (none) 
Explanation 
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Explanation/Reference: 

QUESTION 8 

Monique's laptop was stolen. Monique had locally encrypted the databases on her machine using medium encryption. 

Which one of the following can unauthorized users do? 

A. Compact the databases 

B. Nothing 

C. Read copies of the databases made through the operating system 

D. Use their user ids to access local databases on Monique’s workstation 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 9 

When enabling his XPages application for mobile access, which best describes the options Enrique should consider? 

A. XPages can be viewed without any additional changes on an iPhone or other iOS device. 

B. It might be appropriate to include only a subset of functionality because of the different screen size. 

C. The screen size means different navigation might be required. 

D. All of the above. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 10 

Juanes needs to import some data from a custom application not using a standard database engine, which is being migrated to a Lotus Notes/Domino application. 

How can he accomplish this task? 

A. Export the data to XML on the old application and import it using XMLT. 

B. Use Lotus Enterprise Integrator. 

C. Import data using one of the built-in collection services like DECS or connectors. 

D. Export the data from the old application to one or more ASCII files and import them by using LotusScript file access methods. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 11 

Winnie is enhancing the interface on the Corporate Phone Book Web application. Ted, the graphics designer who is providing Winnie with the images for her Domino application, as suggested that she use image resource sets. 

What is a feature that Winnie can incorporate by using image resource sets? 

A. A horizontal image set can be used to add effects when a user hovers the mouse over an image. For example, the normal image could be replaced with an image with different coloring when the mouse hovers over it. 

B. A vertical image set can be used to incorporate effects using the onmouseover, onmouseout, and onclick events of an image on an XPage. 

C. A vertical image set can be used to incorporate effects using the Normal, Mouse-over, Selected, and Mouse-down image states of a Domino Web page image. 
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D. A horizontal image set can be used to add effects when a user hovers the mouse over an image. For example, the normal image could be replaced with a larger image when the mouse hovers over it. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 12 

Sonia has been asked to rewrite her company's "Careers" Domino Web site using XPages. One of the benefits expected from the new development is better response time for the users. 

What is one reason why XPages may offer better performance versus earlier Domino Web sites? 

A. XPages avoid formula language, thereby saving the time incurred by the formula parser on the server. 

B. XPages are based on JSPs, which are faster than Domino HTML rendering. 

C. The custom controls that ship with XPages provide optimized widgets that may perform better than those developers could produce on their own. 

D. XPages are AJAX-enabled, which can offer response time improvements due to partial page refreshes. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 13 

David migrates an XPage application from his development environment to his test server. When he tests the application, his browser returns the HTTP 403 error message. 

What is the most probable cause? 

A. He is opening the application in the Lotus Notes client. XPages applications can only be viewed on the web. 

B. The application is signed with a development ID. It needs resigning with an ID trusted to run XPages on the test server. 

C. The test server is not running the HTTP task. 

D. He was developing using Firefox but is now looking at the application in Internet Explorer. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 14 What is the purpose of using XSLT in a Lotus Domino 

Web application? 

A. To define what DLX should be available for export. 

B. To allow a Web service to interact with a Java agent. 

C. To display a view as HTML without using a Java applet. 

D. To transform XML documents to HTML or even to another XML document. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 
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Correct Answer: 

QUESTION 15 Which of the following statements describes the 

function of SSL? 

A. SSL encrypts the transmission of HTTP by using a registered certificate as an encryption key. 

B. SSL encrypts the database by creating a certificate authority as a key ring. 

C. SSL encrypts the database ahead of transmission by using a SOCKS proxy. 

D. SSL encrypts the transmission of HTTP by using the user’s ID as an encryption key 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 16 Arthur has created an XPage to display a list of available meeting rooms. When Arthur views the XPage in a browser, he sees the message Error 403 HTTP Web Server: You are forbidden to perform 

this operation. 

What does Arthur need to do to view the XPage? 

A. Make sure that Arthur has the access level in the access level in the access control list that is set to Designer. 

B. Make sure that Arthur has the access level in the access level in the access control list that is set to Manager. 

C. make sure that Arthur is listed in the Sign agents or XPages to run on behalf of the invoker field in the Web Server > Programmability Restrictions section of the server record. 

D. Make sure that Arthur is listed in the Sign agents or XPages to run on behalf of the invoker field in the Security > Programmability Restrictions section of the server record. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 17 What best describes simple 

Actions for XPages? 

A. Simple actions are preprogrammed functionalities that can be selected to be executed on an event within a control or within the XPage. 

B. Simple actions are predefined shoppers of program code that you can define in the code section of an application. 

C. XPages does not support simple actions. Instead, you have the possibility to define custom controls, which provide the same functionality as the simple Actions that you now from elsewhere in Lotus Domino Designer. 

D. Simple actions make it possible to do web application programming by dragging and dropping. 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 18 

Mary is posting a discussion database on the Web. She would like to give general users Author access to the database, as long as they identify themselves and have registered with her site. 

Which one of the following should Mary do to ensure that all users accessing her database are identified and have Author access? 

A. Set the database ACL Default entry to Author and set the Anonymous to No Access. B. 
Create an Authors field on her forms and set it to Anonymous 

C. Set the database ACL Default entry to No Access and set the Anonymous to Author. 

D. Set the form security property, “Who can create documents with this form”, to only allow users in the Author role. 

A 
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Section: (none) 
Explanation 

Explanation/Reference: 

 

QUESTION 19 

Marta must implement a new application for a library. People have asked to use the application from both the Lotus Notes client and a web browser. Asking developers to best implement these requirements, she got different design answers. 

Each of the following statements is true about XPages, except which one? 

A. XPages can be to implement both user interfaces at once. 

B. Custom controls cannot be used for web and Lotus Notes at the same time. 

C. When implementing the application with XPages, they are built without using framesets. 

D. With forms, people are often using different forms for web and Lotus Notes. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 20 XPages are Ajax-enabled. Which option best describes what that 

statement means? 

A. With Ajax, XPages can be partially refreshed instead of reloaded completely for each change. 

B. Ajax allows for lazy loading of content and code. 

C. With Ajax, XPages can provide type-ahead. 

D. All of the above. 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 21 

DJ is developing his first Lotus Domino application. He wants to show a particular set of data to unauthenticated users and provide additional data to authenticated users. 

Which of the following can DJ use to determine whether the user is authenticated or not? 

A. @IsAuthenticated to determine if the user is authenticated or not 

B. @WebUserName, which returns an empty string ( “” ) when a user is not authenticated 

C. @UserName, which returns ‘Anonymous” for unauthenticated users 

D. @WebName to get the current user’s name 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 22 

Which of the following describes the destination URL that is generated by Lotus Domino when the user enters */projects/cio/index.html as the URL? 

A. /projects/index.nsf/cio?OpenPage 

B. /projects/projects.nsf/cio?OpenPage 

C. /projects.cio.nsf/index.html} 

D. /projects.cio/nsf/index?OpenPage 
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Correct Answer: 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 23 

Josh needs to associate the Price and ProductName fields of the Sales database with fields from the Inventory table in a relational database. His company uses DECS. He has created a Data Connection Resource to handle the connection to 

the Inventory table. 

What is the next step to make this connection available to fields on the Product form? 

A. From the Advanced tab of the ACL, select “Allow connection to external databases using DCRs”. From the Security tab of the Form Properties dialog, click Browse by the Data Source Options and select the DCR. 

B. From the Advanced tab of the Database Properties, select “Allow connection to external databases using DCRs”. From the Defaults tab of the product form properties dialog, click Browse by the Data Source Options and select the DCR. 

C. From the Advanced tab of the Database Properties, select “Allow connection to external databases using DCRs”. From the Data Connection Resource Properties, click the Product form under “Connection enabled for”. 

D. From the Basics tab of the Database Properties, select “Allow connection to external databases using DCRs”. From the Defaults tab of the Form Properties dialog, click Browse by the Data Source Options and select the DCR. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 24 

To approve an expense report, Quy goes to a controlled-access section and marks the Status field "Approved". Status is a sign-enabled field. 

When is the signature attached? 

A. Immediately 

B. When the document is mailed 

C. When the document is saved 

D. When the document is encrypted 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 25 Joanne is working with two other developers on a company-wide intranet project built in XPages. Each developer has taken responsibility for different aspects of the site, but some of these tasks occur in multiple places 

within the intranet. 

How should they manage these tasks? 

A. Create subforms within the XPages to separate and reuse the code. 

B. Create custom controls for each aspect of the site that is repeated in multiple places. 

C. Create separate XPages for each primary area, then use the Source tab of the Editor view to copy the XML representing each subset of functionality and paste it onto the necessary XPages. 

D. Create sections on each XPage to incorporate the shared functionality. 

B 

QUESTION 26 An XPage application is mostly made up of the 

following elements: 

A. Forms, views, subforms, pages, framesets, and agents 

B. XPages only 
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Section: (none) 
Explanation 

Explanation/Reference: 

 

C. Forms, views, XPages, CSS and themes, and outlines 

D. Forms, views, XPages, custom controls, and CSS and themes 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 27 Which option best describes the benefits of being 

Ajax-enabled? 

A. Content and code can be loaded when required, rather than when the page is initially displayed. 

B. You do not need to use agents to interact with the server dynamically. 

C. Ajax functionality can be implemented with much less coding than a traditional Lotus Domino web application. 

D. All of the above. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 28 Jim is looking at the Properties dialog 

box for an agent. 

Which one of the following best describes the use of the "Allow user activation" option? 

A. Allows users with Editor access or above in the ACL to enable an agent 

B. Allows users with Editor access or above in the ACL to run an agent 

C. Allows users with Author access or above in the ACL to run an agent 

D. Allows users with Author access or above in the ACL to enable an agent 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 29 Yolanda has built the XPages for the sales application. The functionality is working properly, and it is now time to apply the corporate branding. Yolanda has read that XPages can use themes and CSS for affecting the 

appearance of the UI. 

What is a distinction between themes and CSS? 

A. CSS is used to control the presentation of data – such properties as color, font, and positioning. Themes cannot manage the same items as CSS, but themes can be used to control functional properties such as the number of 

displayedview rows. 

B. Themes are set the server level to control one, many, or all XML properties of all XPages running on the server. One must use CSS to customize the UI of specific applications. 

C. Themes and CSS each can control all of the same items. The difference is that themes can be used to apply to some or all applications on a server, while CSS is application-specific. 

D. Themes can be used to control any XML properties of any XPages running on the server, including CSS style properties. Themes are different from style sheets in that they are not restricted to CSS styles. 

Correct Answer: D 

Section: (none) 
Explanation 
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Correct Answer: 

Explanation/Reference: 

QUESTION 30 

Dierdre is periodically asked to update the Readers field in documents created with the SalesOrder form. If a person's name changes, they are no longer able to access documents they'd been able to access in the past. Dierdre would like the 

Readers fields to be automatically updated when someone's name has been changed in the Domino directory. 

How can she do this? 

A. Ask a Notes Administrator to enable “Maintain Reader/Author field consistency” on the Security tab of the server document for her application server. 

B. Open the Security tab of the database properties. In the selection list for Administration Actions, choose “Update all readers and Authors fields”. 

C. Open the Advanced tab of the database ACL. In the selection list for Action, choose “Modify all readers and Authors fields”. 

D. Open the Security tab of the SalesOrder Form properties. Place a checkmark next to ‘Enable adminp updates”. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 31 

Dudley is looking to improve the performance on an XPages application he built for the marketing department. This application is not used by a large amount of users at one time. 

Which server page persistence setting would work best in this scenario? 

A. Keep only the current page on disk 

B. Server default 

C. Keep pages in memory 

D. Keep pages on dick 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 32 Emily is preparing to build an application for using browsers. She is considering 

using XPages. 

Which of the following statements about XPages is not valid? 

A. XPages can be deployed to a Lotus Domino 8 server. 

B. XPages can create and manipulate Lotus Domino data on other servers, provided they are within they are within the same trusted domain. 

C. XPages can be used on a variety of browsers with minimal changes. 

D. XPages can be made multilingual by using built-in Lotus Domino Designer functionality. 

A 

QUESTION 33 

Sarah needs to hide an input control that holds temporary data and access its value with client side JavaScript. 

How can she accomplish that task? 

A. She deactivates the visible property of the control, then the control itself is not visible, but she can access it with JavaScript. 

B. She sets the loaded property of the input control to false, then the control itself is not visible, but she can access it with JavaScript. 

C. She goes into the source code and precedes the code for the input control with “//”. 

D. She has to surround the input control with a <div> section and set the display attribute to none. 

www.vceplus.com - VCE Exam Simulator - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - PDF Online

https://vceplus.com
https://vceplus.com


Section: (none) 
Explanation 

Explanation/Reference: 

 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 34 

Which @Command can be used in an XPage? 

A. @Command([EditProfile];formname;uniquekey) B. 

@Commands are not available for use in an XPage. 

C. @Command([ToolsRunMacro];agent) 

D. @Command([EditDocument]) 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 35 

Catherine has upgraded her development server from 8.5.1 to 8.5.2. She wants to take advantage of 8.5.2 functionality now, but when she tries to save her XPages, they are generating error messages saying that the functionality is not 

supported in 8.5.1, which is the minimum supported version for this application. 

How can Catherine resolve this problem? 

A. She must change the minimum supported release on the XPages tab of the Application properties in Lotus Domino Designer 

B. She needs to upgrade her Lotus Domino Designer client to 8.5.2. 

C. She must run a compact operation on the application to update the ODS. 

D. She must create a template with an 8.5.2 client and copy the design elements across. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 36 

Olga needs to integrate data from an Oracle database into her XPages application. 
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Which of the following options would allow Olga to do that task? 

A. Unfortunately, there is no possibility to access Oracle data from an XPages application. 

B. Olga needs to install the EnterpriseDataCollection library from OpenNTF first. 

C. Nothing. Lotus Notes and Lotus Domino are able Oracle databases directly. 

D. DECS or LEI is installed and configured. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 37 

The Discussion Topics XPage includes a button to take users to the Feedback XPage. Ted has created the Feedback XPage. He now wants to add a Save and close button that saves the user's input, and take the user back to the Discussion 

Topics XPage. 

What is one way that he can do this task? 

A. Drag a new Button control onto the XPage canvas. Leave the button type as Button. For the onclick event, add a simple action selecting Save Document. Specify Discussion Topics as the argument. 

B. Drag a new Button control onto the XPage canvas. Set the button type to Submit. For the oncllick event, add the following server-side JavaScript: Feedback.save(); context.getUrl(“…”); 

C. Drag a new Button control onto the XPage canvas. Leave the button type as Button. for the onclick event, add a simple action selecting Save Data Sources. Specify Discussion Topics as the argument. 

D. Drag a new Button control onto the XPage canvas. Set the button type to Submit. For the onclick event, add the following server-side JavaScript: Feedback.save(); 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 38 

Olivia is writing a Discussion application using XPages. She added a button on her main topic XPage to create a response document for this discussion. 

What should she do to generate the response document? 

A. Add a Create New Document simple action to the form QuerySave event 

B. Add a Create New Document simple action to the button onclick eventC. Add a Create Response Document simple action to the form QuerySave event 

D. Add a Create Response Document simple action to the button onclick event. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 39 Jane is updating a Supplier application for XPages. Currently the Supplier form has a table to allow up to 10 contacts to be assigned. Her users have complained that they often need 

to enter more. 

How can she best change the design to help them? 

A. Create a Contract form to hold contact information. However, users must navigate to a different XPage to create and edit Contacts. 

B. Add five extra rows to the Supplier form and the relevant XPage. 

C. Create a Contact form to hold the contact information. Allow users to create Contacts as child documents on the Supplier XPage and use a repeat control to display the related Contacts. 

D. Use a repeat control on the Supplier XPage that allows them to add as many as they want. 

Correct Answer: C 
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Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 40 

Monica has bound the view named "Open invoices" into her XPages application, which is accessible as view1. For the convenience of the user, she likes to display the total amount of all invoices. 

How can she calculate this amount? 

A. var total:dpuble = 0;var doc:NotesDocument = 

view1.getFirstDocument(); 

While(doc != null) 

{ 

total = doc.getItemValueDouble(‘amount’) + total; var 

tmpdoc:NotesDocument = view1.getNextDocument(); 
doc.recycle(); 

doc = tmpdoc 

} 

B. var allDocs = view1.AllDocuments();var total = 
allDocs.AddValues(‘amount’); C. var total:double = 0; 

var doc:NotesDocument = view1.getFirstDocument(); 

var item:NotesItem; while(doc ! = null){ 

item = doc.getFirstItem(‘amount’); 
total = item + total; 

var tmpdoc:NotesDocument = view1.getNextDocument(); 

doc.recycle(); 
doc = tmpdoc 

} 

D. var total = view1.getSumDouble )’amount’); 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 41 Donna wants to navigate to a 

panel in her XPage. 

Which area would she use? 

A. The Properties view 

B. The Outline view 

C. The Controls view 

D. The Applications view 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 42 

Chris is using a view control to show the data of a Lotus Notes view in his XPages library application to simply scroll through the titles of the books available. This data is all read-only and no processing is done on the data. Users are 

complaining about the performance of this XPage. 

Which would be an option to optimize it? 
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A. Nothing can be done. View data is always cached. 

B. He can change the datacache property of the dominoView data source to id, instead of full. 

C. XPages are storing the data of a Lotus Domino view in an application variable named CurrentViewData. Chris can open the application properties, go to the application properties, go to the Xpages tab and select none for the Cache 
ViewData option. 

D. Nothing can be done. View data is never cached. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 43 

Zachary is creating a new theme for his XPage. How is the theme file coded in the Resources area of the application? 

A. JavaScript 

B. HTML 

C. CSSD. XML 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 44 Clarice has an XPage where she needs to store a value in a browser cookie. Given that the value's name is 'language' and the value is 'Spanish,' what JavaScript code can she 

use to do that? 

A. cookie.language = “Spanish” 

B. var response = facesContext.getExternalContext().getResponse();var 
userCookie = new javax.servlet.http.Cookie(“Cookie”, “Spanish”); 
response.addCookie(userCookie); 

C. cookie.setValue(“language”) = “Spanish”D. var response = 
facesContext.getExternalContext().getResponse(); 

var userCookie = new javax.servlet.http.Cookie(“language”, “Spanish”); 

response.addCookie(userCookie); 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 45 Rebecca has a Rental XPage that updates an underlying document in the database. As the user leaves each field on the XPage, Rebecca wants the underlying document fields 

to be updated. 

What can she use to accomplish this task? 

A. Add a Modify Field simple action to the Edit Box core control onBlur event 

B. Add a Modify Field simple action to the Rental XPage QuerySave event. 

C. Add an Update Field simple action to the Field core control onExit event. 

D. Add an Update Data simple action to the rental XPage onModify event. 

Correct Answer: A 

Section: (none) 
Explanation 
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Explanation/Reference: 

QUESTION 46 Hector is working on an XPages application and wants to let users navigate to particular pages by 

clicking on images. 

How can he do this task? 

A. Define the images’ onclick events to point to simple actions configured as Open XPage Actions and select the appropriate XPage for each image in the Action’s Target property. 

B. Define the images’ onclick events to point to simple actions configured as New Page Actions and select the appropriate XPage for each image in the Action’s Target property. 

C. Define the images’ onclick events to point to simple actions configured as Open Page Actions and select the appropriate page for each image in the Action’s Target property. 

D. Define the images’ onclick events to point to simple actions configured as Open Page Actions and select the appropriate XPage for each image in the Action’s Target property. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 47 Earl is working with the global view object available within 

JavaScript in XPages. 

With what kind of view is he working? 

A. A Domino view 

B. A Notes view 

C. A JSF view 

D. An Eclipse view 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 48 

Terry wants to update the meal service planning XPage application so that users can now use XPages in the Lotus Notes client. 

What does Terry need to do for the application to automatically launch the correct XPage when the database is opened? 

A. Open the database properties, select the Design tab, set the When opened in the Notes client property to Open designated XPage, and then select the correct XPage. 

B. Open the database properties, select the Display tab, set the When opened in the Notes client property to Open designated XPage, and then select the correct XPage. 

C. Open the database properties, select the Basics tab, set the When opened in the Notes client property to Open designated XPage, and then select the correct XPage. 

D. Open the database properties, select the Launch tab, set the When opened in the Notes client property to Open designated XPage, and then select the correct XPage. 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 49 

Juan is integrating an XPage application with his existing company intranet and wants to pull values from cookies. 

What server-side JavaScript code allows him to access cookies? 
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A. facesContext.getHeader(“Cookie”) 

B. facesContext.getExternalContext().getRequest().getCookie() 

C. facesContext.getExternalContext().getCookie() 

D. facesContext.getExternalContext().getRequest().getHeader(“Cookie”) 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 50 

Martin has finished his application and wants to set the launch options to open the database in a browser on the XPage named home. 

Which method describes the best way of doing this task? 

A. Open the Application Properties design element and click the Launch tab. Then, set the Web Browser launch option to Open designated XPage and select the “home” XPage. 

B. Open the Application Properties design element and click the Launch tab. Then, set the Web Browser launch option to Use Notes launch option. 

C. Open the Application Properties design element and click the Launch tab. Then, set Notes client launch option to Open designated frameset. 

D. Martin does not have to do anything. The application already knows which XPage to open for a web browser. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 51 

Donna is interested in using the Single copy XPage design to improve the performance of her application. 

Which of the following design elements are not supported in this feature? 

A. Themes 

B. Custom controls 

C. XPages 

D. Views 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 52 

Anna, who has developed traditional Lotus Notes application for years, is working on her first XPage application. Until now, she always tried to achieve goals by using as much @formulas as possible. Now she is asking her colleagues about 

@formulas with XPages. 

Which of the following answers is wrong? 

A. Thomas said that there is no @formula language with XPages. 

B. Marc explained that she can use most of the @formulas within JavaScript. 

C. Pete said that she can use @formulas, but because it is running inside JavaScript, @formulas are case sensitive, and instead of semicolons it uses commas to separate parameters. 

D. Adam told her that she can use @formulas, but some of them have different functionality. 

Correct Answer: A 
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Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 53 Clay is updating the ticket processing application to use XPages in the Lotus Notes client. He wants to make sure that existing documents created with the ticket approval form now open in the new 

approval XPage. 

What does Clay need to do to accomplish this task? 

A. From the form properties, click the Form Info tab, and in the On Open section, select the approval XPage from the Display XPage instead property. 

B. From the form properties, click the Form Info tab, and in the On Web Access section, select the approval XPage from the Display XPage instead property. 

C. From the form properties, click the Defaults tab and in the On Open section, select the approval XPage from the Display XPage instead property. 

D. From the form properties, click the Launch tab and in the On Open section, select the approval XPage from the Display XPage instead property. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 54 

George has been asked to create a new Lotus Notes XPages application that is used in the Lotus Notes client and on the web. George knows Lotus Notes development, but not XPages yet. 

How can he use LotusScript in the new application? 

A. He cannot use LotusScript at all anymore and needs to rewrite all of his existing agents and event code to use JavaScript and Java. 

B. He can just copy and paste the LotuScript into the Xpage event model and it will work. 

C. He can call LotusScript agents from his XPages, but it would be better if he converted them into JavaScript in his XPages. 

D. He can use LotusScript agents in his application and he does not need to learn anything else. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 55 Manesh is developing the ActivityPlanner XPage. He now needs to add check boxes that allow users to select one or more of the activities of "Monthly Volunteering," "New Hire Orientation," and 

"Quality Circle." 

How can Manesh create the check boxes? 

A. From the Controls palette, drag “Other” onto the XPage and select Other Controls > Checkbox group. Open the Source tab, and within the 

xp:checkBoxGroup tag, enter these lines: <xp:selectItem itemLabel=”Monthly Volunteering”itemValue=”01”></xp:selectItem> 
<xp:selectiItem itemLabel=”New Hire Orientation” 
itemValue=”02”></xp:selectItem> <xp:selectItem 
itemLabel=”Quality Circle” 
itemValue=”03”></xp:selectItem> 

B. From the Controls palette, drag “Check Box” onto the XPage canvas. open the Source tab, and within the xp:checkBox tag, enter these 
lines:<xp:selectItem itemLabel=”Monthly Volunteering” itemValue=”01”></xp:selectItem> 
<xp:selectitem itemLabel=”New Hire Orientation” 

itemValue=”02”></xp:selectItem> <xp:selectItem 

itemLabel=”Quality Circle” itemValue=”03”></xp:selectItem> 

C. Create a Check box group control on the XPage canvas. In the Options area of the Properties tab, enter the following values on separate 

lines:Monthly Volunteering 

New Hire Orientation 
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Quality Circle 

D. Drag a Check Box control onto the XPage canvas. In the Options area of the Properties tab, enter the following values lines:Monthly Volunteering 

New Hire Orientation 

Quality Circle 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 56 

Pablo has created an XPage to use for browsing and editing customer data. He would like to add a button which asks users if they are sure that they want to update the customer data. The button saves the changes if users indicate that they 

are sure. 

How can Pablo create this button? 

A. Drag a button control from the core controls onto the XPage canvas. From the Control properties, select Save as the button type. A confirmation prompt is included by default. 

B. Drag a button control from the core controls onto the XPage canvas. From the Control properties, select Submit as the button type. From the events panel, add a client-side simple action. Select Confirm Action for the action. 

C. Drag a button control from the core controls onto the XPage canvas. From the Control properties, select Save as the button type, and enable the Confirm option. 

D. Drag a button control from the core controls onto the XPage canvas. From the Control properties, select Submit as the button type. From the events panel, add a server-side simple action. Select Confirm Action for the action. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 57 Kaitlyn has been asked to track which browser versions people are using to access the Customers XPage. She wants to add code that writes the browser version to the server log whenever a user 

opens the XPage. 

What server-side code can Kaitlyn add to do this task? 

A. Add this code in the deforePageLoad event of the XPage:print(headerValues.getHeader(“User-Agent”)); 

B. Add this code in the beforePageLoad event of the XPage: 

var req = facesContext.getExternalContext().getRequest(); 

print(req.getHeader(“User-Agent”)); 

C. Add this code in the onLoad event of the XPage: 

var req = facesContext.getExternalContext().getRequest(); print(req.get(HTTP_USER-AGENT)); 

D. Add this code in the onLoad event of the XPage:print)headerValues.getHeader(HTTP_USER_AGENT)); 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 58 Caleb added a View control to his Contacts XPage. What type of control is 

the View control? 

A. Container control 

B. Core control 

C. Custom control 

D. Theme control 
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Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 59 

Lainey has recently upgraded to Lotus Notes Domino 8.5. She is now exploring the design of her applications to see what new features might be available. 

What is the purpose of the controls palette that Lainey sees? 

A. The controls palette contains controls, such as Edit Box, File Upload, and Table that the developer can drag onto the XPage canvas. 

B. The controls palette contains items like Edit Box, Button, and Label that the developer can drag onto XPages and forms. The controls palette is not available for views and pages. 

C. The controls palette contains UI and other controls (such as Button, Link, and Image) that allow the developer to drag controls onto XPage or page elements. The controls palette is not available for other elements. 

D. The controls palette is another way to access the same items that are available from the Create menu for forms, views, XPages and other design elements. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 60 

Martha uses the outline view to navigate the design of an XPage. When she starts Lotus Domino Designer, she notices that the outline view no longer shows. 

What can she do to bring back the outline view? 

A. Click Perspective > Show Eclipse Views > Outline. 

B. Click Project > Show Eclipse Views > Outline. 

C. Click Windows > Show Eclipse Views > Outline. 

D. Click Design > Show Eclipse Views > Outline. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 61 Jason has entered the group salesforce to the ACL of all of his XPages in the new CRM application. He gave this group Editor rights. Unfortunately, none of the group members are able to access 

the application. 

What could be the reason for it? 

A. ACL in XPages are a feature, that will be supported only in a future version of Lotus Domino. The property is there, so that people are able to prepare their applications for the suture. 

B. There is no entry for the salesforce group in the Application ACL. 

C. When Jason saved the XPages design element, there was an error ACL Entry not found message. he forgot to correct this problem. 

D. Jason needs to go to the Application properties, select the XPages tab and activate Allow ACL in XPages. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 62 
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Martha has a Submit button on her Timesheet XPage. When clicked, the button uses the Save Document simple action to save the data to the underlying document. What parameters does Martha 

have to provide to the Save Document simple action? 

A. pageName, mergeConflicts 

B. documentName, saveImmediate 

C. forceSave, createResponse 

D. none 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 63 

Lian has used the Set Value simple action in the Timesheet XPage to set the value of a computed expression. 

What does the generated XML look like on the XPage after this simple action has been added? 

A. <xp:this:action> <xp:setValue fieldName=[ce] value=”Approved”></xp:setValue> 

B. <xp:this.action> <xp:setValue value=”Approved” 
binding=”#{document.Status}”></xp:setValue></xp:this.action> 

C. <xp:this.action> <xp:setValue docPage=”/Timesheet.xsp” fieldName=[ce]value=”Approved” 
createConflict=false> </xp:setvalue> 

D. <xp:this.action> <xp:setValue page=”/TimesheetApproved.xsp” 

binding=[ce]value=”Approved”> </xp:setValue> 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 64 

Mike developed a billing application that should be used with the browser and with XPages. He tested his application locally until it was finished and ready to be deployed to the server. After installing the application on the server, Mike is 

testing the application again. But he is not able to even invoke the application. In the browser, he gets the message Error 403, HTTP Web Server. You are forbidden to perform this operation. 

What could be the reason for this error message? 

A. Because the application is signed with Mike’s user name and his name does not show in the following entry in the Lotus Domino Server document: On the Security tab, inside the Programmability Restriction section the field labeled: 
Signagents or XPages to run on behalf of the invoker. The application needs to be signed with an ID that has rights to run agents or XPages on the server. 

B. Mike needs to wait about an hour after deploying the application to the server until the server has cleared all access rights. 

C. Mike needs to open the application properties and click the Server tab. In the security section, he needs to enter the name of the server into the Administration Server field on the same tab. 

D. An administrator must check and unlock Mike’s application first. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 65 Gustav has added a View control to his XPage. He needs to allow users to delete 

documents from the view. 

How can he do this task? 
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A. Enable the Column Display property check box and add a button with a simple action defined to Delete Selected Documents. 

B. Add a button with a simple action defined to Delete Selected Documents. 

C. Enable the Column Display property check box, and add a button with server-side JavaScript in the button’s onclick event that has used the @Function script library to execute @Command[(DeleteDocument)]. 

D. Enable the Column Display property check box and the View property Allow Deletion. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 66 

Yvette has been asked to help troubleshoot a LotusScript agent that produces the weekly sales report. The agent is taking longer than expected to run. 

Which step should Yvette take to help her analyze the agent's performance? 

A. Add “Option Profile” to the “(Options)” object in the agent. 

B. Select File > Tools > Remote LotusScript DebuggerC. Select “Enable agent profiling” in database properties. 

D. Select “Profile this agent” in the Agent properties. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 67 

Martha needs to store a value and reuse it throughout the life of each Web user's interaction with her XPages application. 

How should she set the value named 'Title' to 'Senior Project Manager?' 

A. sessionScope.Title= ”Senior Project Manager” 

B. applicationScope.Title= “Senior Project Manager 

C. applicationScope.setValue(“Title”, “Senior Project Manager”) 

D. sessionScope.setValue(“Title”, “Senior Project Manager”) 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 68 Hadi is creating a new XPage. His XPage design now shows the company 

logo and banner. 

How can Hadi now add fields to the XPage? 

A. For each field, drag the associated type of control (such as Edit Box, Check Box, radio Button, and so on) from under XPages on the Applications panel to the XPage design. 

B. For each field, drag the associated type of control (such as Edit Box, Check Box, radio Button, and so on) from the Core Controls to the XPage design. 

C. On the XPage design, click and drag to draw a box to create each field. As the mouse button is released for each field box, select the type of control to associate with the field (such as Edit Box, Check Box, Radio Button, and so on). 

D. Right-click where each field should be placed and select Insert > Field and select the type of field (such as Edit Box, Check Box, radio Button, and so on). 

Correct Answer: B 

Section: (none) 
Explanation 
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Explanation/Reference: 

QUESTION 69 

Marge wants to track user preference information while users navigate through her Web site, but does not want to require users to authenticate when accessing the site. 

Which of the following should she use to track the user information? 

A. Cookies 

B. User profile documents 

C. The user must authenticate 

D. Servlets 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 70 

Qiang needs to add a button to the Contact XPage. When clicked, this button should delete the currently open document from the application. 

What is one way that Qiang can add this button? 

A. Drag the Data control from the core controls onto the XPage canvas. From the Control properties, set the Label to Delete. On the Operations tab, select Current document and Delete. 

B. Drag a Button control from the core controls onto the XPage canvas. From the Control properties, set the Label to Delete. On events panel. select the Mouse onclick event, and add a server-side simple action. Select Delete for theaction. 

C. Drag the Data control from the core controls onto the XPage canvas. From the Control properties, set the Label to Delete. In the Options area of the properties, select Delete for the Action, and select Domino Document for the Target.D. 

Drag a Button control from the core controls onto the XPage canvas. From the Control properties, set the Label to Delete. On the events panel, select the Mouse onclick event, and add a client-side simple action. Select Delete for the 

action. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 71 

Frederick has added a button to his XPage and labelled it Edit. 

What should he do to make the button put the document in edit mode? 

A. Add server-side JavaScript to the button’s onclick event and use the @Function script library to execute @Command[(EditDocument)]. 

B. Add a simple action to the button’s onclick event and select the Change Document Mode Action, specifying Edit as the mode. 

C. Add a simple action to the button’s onclick event and select the Edit Document Action. 

D. Add client-side JavaScript to the button’s onclick event and use the @Function script library to execute @Command[(EditDocument)]. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 72 Ashley is writing a server-side script to process the request parameters that are passed in her 

Registration XPage. 

What global object should she use to access the parameters that she's interested in? 
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A. header 

B. cookie 

C. param 

D. requestScope 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 73 

Ida has developed the needed functionality in the Customers XPage of her application. The Web design team has provided her with the internal.css stylesheet. 

After Ida imports the stylesheet to her application, how can she add the stylesheet to the XPage? 

A. From the Applications view, select resources > Style Sheets > internal.css. From the Wiring tab of the Properties view, click “Add” and select XPage > Customers. 

B. From the Applications view, double-click to open the internal.css style sheet. From the Associations tab of the Properties view, click ‘Add association” and select XPage > Customers 

C. Open the XPage in Lotus Domino Designer. From the Style tab of the Properties view, click “Add style sheet to page” and select internal.css. 

D. Open the XPage in Lotus Domino Designer. Right-click an open area of the XPage and open the Properties window. Select internal.css for the Style Sheet option. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 74 

With server-to-server replication, what is the minimal access level, that a server must have to an application to replicate not only documents, but also design elements? 

A. Manager 

B. Designer 

C. Server always replicate any document independent of their access rights 

D. Reader 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 75 Jackson is using the FTSearch method of the NotesDatabase class to to return a NotesDocumentCollection. Jackson notices that the NotesDocumentCollection does not contain all the documents that 

he would expect. 

What would cause this issue? 

A. The maximum number of documents returned by FTSearch is 5,000 documents. 

B. The maximum number of documents returned by FTSearch is 2,000 documents. 

C. Jackson did not set the MaxDocs parameter on the FTSearch method to All to return all valid documents. 

D. Jackson did not set the MaxDocs parameter on the FTSearch method to All to 0 to return all valid documents. 

Correct Answer: A 

Section: (none) 
Explanation 
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Explanation/Reference: 

QUESTION 76 Which of the following Domino language lists supports importing and 

exporting DXL? 

A. LotusScript, Java, and Formula language 

B. Java only 

C. LotusScript and Java 

D. LotusScript only 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 77 

Alison would like to perform an @DbLookup to the Keywords view from her XPage. The same code needs to run in a browser and in XPages in the Lotus Notes client. 

Which of the following options is the correct syntax? 

A. @DbLookup(“”, “Keywords”, “Countries”, 2,[FAILILENT]) 

B. @DbLookup(@DbName(), “Keywords”, “Countries”, 2, “[FAILSILENT]”) 

C. @DbLookup(“”; “Keywords”; “Countries”; 2; [FAILILENT]) 

D. @DbLookup(@DbName(), “Keywords”, “Countries”, 2, [FAILSILENT]) 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 78 

With her Lotus Notes applications, Marianne has extensively used the QueryOpen event of the Notes Form to change the representation of some data. 

Is there a way to do the same with XPages? 

A. Unfortunately, there is no way to influence any data when XPages are loaded. You have to change them after loading and before the user gets control. 

B. Yes, on the Events tab of any XPage, you can find the BeforePageLoad event, where you can do similar things. 

C. Unfortunately, there is no comparable functionality in XPages to do similar things. 

D. Yes, on the Basic tab of any XPage, you can find the QueryOpen property, which can be used. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 79 

Cade is building an XPage for the Sales application. What are the options from which he can select when defining a data source from the data palette? 

A. @DbLookup and @DbColumn 

B. Domino view and Domino document 

C. Data connections, DB2 access views, and file resources 

D. Data connections and DB2 access views 
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Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 80 Grace would like to emulate a PostOpen event on her XPage by using the Execute 

Script simple action. 

What options can she use to build her script logic? 

A. CSS, HTML, JavaScript 

B. Java, JavaScript, LotusScript 

C. JavaScript, Expression Language, Custom 

D. @Formula, LotusScript, Java 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 81 Which of the following options cannot be used in a server-side 

JavaScript library? 

A. XPages @Functions 

B. Java functions 

C. Global functions 

D. Simple actions 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 82 How do you get a collection of all documents of the current database in an 

XPages environment? 

A. var ws = session.getCurrentWorkspace;var db 
= ws.CurrentDatabase; var documents – 
db.AllDocuments(); 

B. var db:NotesDatabase = 
session.CurrentDatabase;var documents = 

db.AllDocuments(); 

C. var s:NotesSession = new NotesSession;var db 

= s.getCurrentDatabase(); var documents – 

db.getAllDocuments(); 

D. var documents = database.getAllDocuments(); 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 
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QUESTION 83 Chester has an XPage that is reporting an Error 500 HTTP Web Server: Command Not 

Handled Exception. 

How can he get more details about the problem? 

A. Double-click Application Properties in the applications navigator, select the XPages tab, and enable the “Display default error page” option. 

B. Double-click Application Properties in the applications navigator, select the XPages tab, and disable the “Display default error page” option. 

C. Click the Application title in the applications navigator, select the Properties View, select the Design tab, and disable the ‘Display default error page” option. 

D. Click the Application title in the applications navigator, select the properties View, select the Design tab, and enable the “Display default error page” option. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 84 

After importing a WSDL file into a LotusScript script library to generate Web service consumer code, what is the basic structure of the code that is generated? 

A. A public function or subroutine for each Web service method that is defined, with custom types for complex data types if necessary. 

B. A single class with a method for each Web service method that is defined, and additional classes for complex data types if necessary. 

C. A single with a method for each Web service method that is defined, and custom types for complex data types if necessary. 

D. A class that connects to the Web service, a public function or subroutine for each Web service method that is defined, and additional classes for complex data types if necessary. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 85 

Stefan would like to add a custom control to the department's order processing XPage application that displays the approval routing status. He wants the custom control to only display to certain users. 

How can Stefan accomplish this task? 

A. From the custom control, select the Security view and click the All properties tab. Expand the data > acl > entries > aclEntry[0] property. Add an entry for the person or group that you want to give access to. 

B. From the XPage, select the Properties view and click the All Properties tab. Expand the data > acl > entries > aclEntry[0] property. Add an entry for the person or group that you want to give access to. 

C. From the XPage, select the Security view and click the All Properties tab. Expand the data > acl > entries > aclEntry[0] property. Add an entry for the person or group that you want to give access to.} w selected below is selected and 
alsomake sure that Outline is selected. 

D. From the custom control, select the Properties view and click the All properties tab. Expand the data > acl > entries > aclEntry[0] property. Add an entry for the person or group that you want to give access to. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 86 Emma has upgraded her production Lotus Domino server 

from 7.0.4 to 8.5.2. 

Which new setting in the Server document should she be aware of, if she wants to run XPages securely? 

A. On the Internet Protocols tab, the HTTP setting is Enable as XPages server. 

B. On the Ports tab, click the Internet Protocols tab, and under Web, she should enable the run XPages in HTTPS setting. 

C. On the Security tab, she should set the Sign applets and XPages to run on behalf of the invoker setting with the appropriate trusted IDs. 

D. On the Security tab, she should set the Sign agents or XPages to run on behalf of the invoker setting with the appropriate trusted IDs. 
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Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 87 Using a web browser, Marc is accessing Lotus Domino sites, but 

does not log in. 

Which ACL setting would allow him to access the databases? 

A. The $$WebUser role is set to Reader. 

B. The Anonymous user is set to Reader 

C. The $$WebUser user is set to Reader. 

D. The Anonymous role is set to Reader. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 88 Andre is using mail encryption on documents that are being routed to other 

members of his team. 

Which one of the following keys is used to decrypt the documents? 

A. Server’s private key 

B. Andre-s private key 

C. Recipient’s public key 

D. Recipient’s private key 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 89 

Eamonn has developed and supported several Domino Web applications over the years. He has been told that one of the benefits of XPages is that XPages are AJAX-enabled. 

What is a benefit that Eamonn might expect to see if he incorporates AJAX-enabled XPages in his applications? 

A. Faster development because XML is now automatically converted to JSON 

B. Faster development using Shared Widgets resources 

C. Faster response time due to partial page refreshes 

D. Faster response time because JavaScript is now all server-side 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 
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QUESTION 90 Linda would like to have a navigator pane for her 

XPages application. 

What would be the best way to implement this pane? 

A. She downloads and installs a JavaScript library for a menu. 

B. She has to build the navigator by using a Notes view with documents defining each link on her navigator. She then integrates that view in each XPage that her application needs. 

C. She puts the links for her navigator together by building a custom control and can use that for every page that she needs. 

D. Unfortunately, there is no simple way to do it, so she has to build it on every XPage. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 91 

Marie develops a web shop application. This web shop is used by different divisions of her company. While the business logic for each of these web shops is always the same, she needs to make the user interface distinguishable between the 

different instances of the shop. 

How can she achieve that task? 

A. All of the previous options are possible. The most flexible way of doing it is fitting the different resources like stylesheets, Dojo themes, and soon together as a theme and define different themes for each different web shop. 

B. Marie develops different Cascading Style Sheets for each division. 

C. Marie develops different applications for each division. 

D. Marie makes the differences by using different Dojo themes per instance. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 92 

Jon wants to use an XPage application for both the Lotus Notes clients and web browsers. Jon's company has Lotus Domino and Lotus Notes 8.5 installed. 

What does Jon need to do to make this application work? 

A. Jon needs to set the launch options for the Notes clients and web browsers to Open designated XPage and set which XPage opens. 

B. Jon must upgrade the Lotus Notes clients to 8.5.2 or later. Then, he needs to set the launch options for the Notes clients and web browsers to open designated XPage and set which XPage opens. 

C. Nothing, Lotus Notes clients cannot use XPage applications. 

D. Jon must upgrade the Lotus Notes clients to 8.5.1 or later. Then, he needs to set the launch options for the Notes clients and web browsers to Open designated XPage opens. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 93 Frank has a Purchase Order application where Order lines are created as child documents to the Purchase Order header. The Order lines are displayed in an embedded view. The formula in the first column of the view is 

@Text($Ref). 

How might the application be optimized? 

A. Use @DbLookup formulas within a repeat control, instead of a View panel. 

B. Use a repeat control whose value is currentDocument.getDocument().getResponse(). 
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C. Use a multivalue field to hold the Order lines, instead of using child documents. 

D. Enable the single copy XPage design on the XPage tab of the Application properties. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 94 Which one of the following programming languages or language combinations can be used to build an agent that retrieves data from non-Domino servers 

over the Internet? 

A. JavaScript 

B. LotusScript in combination with C 

C. This task is not possible using a Web agent. 

D. Java 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 95 

Elaine is working on an XPage and she wants to use a custom control that she created earlier, but the custom controls are not visible in the Controls view. 

Why is this happening? 

A. The custom control that Elaine wants was created in another application and no custom controls have been created in this application yet 

B. The custom control that Elaine wants is available from the Custom Controls view in the application navigator, but to have it available on a particular XPage, she has to drag it from there onto the XPage. 

C. The Custom Controls window was closed accidentally. It can be reopened by selecting File Preferences > Domino Designer > Palette, and selecting Custom Controls Palette. 

D. The Custom Controls window was closed accidentally. It can be reopened by selecting Window > Reset Perspective from the menus. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 96 Clay is updating the ticket processing application to use XPages in the Lotus Notes client. He wants to make sure that existing documents created with the ticket approval form now open in the new 

approval XPage. 

What does Clay need to do to accomplish this task? 

A. From the form properties, click the Defaults tab and in the On Open section, select the approval XPage from the Display XPage instead property. 

B. From the form properties, click the Form Info tab and in the On Open section, select the approval XPage from the Display XPage instead property. 

C. From the form properties, click the Launch tab, and in the On Open section, select the approval XPage from the Display XPage instead property. 

D. From the form properties, click the Form Info tab, and in the On Web Access section, select the approval XPage from the Display XPage instead property. 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 97 Joy wants to implement single sign-on for her Lotus Domino 

Web applications. 

What does she need to do? 

A. Update the “Session authentication” field in the server’s configuration document. 

B. Encode the Single Sign-On form in each database 

C. Enable “Use Single Sign-on” in the database properties. 

D. Ensure that all servers are using the same certificate authority. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 98 

Marcel puts an XPage together, which is used for registration of users. He plans to use three different buttons: Newsletter, Forum, or Cancel. Each button should load a different next page. 

How can this task be accomplished? 

A. Using the Open Next Page Simple action, simply select each button for the next page. 

B. There is no way to accomplish this task. After pressing any submit an XPages application always returns to the home page. 

C. To achieve this task, you have to write your own Java servlet and install it to all the servers and clients, so that your application can run. Then you can trigger your servlet to produce the page for each button. 

D. For each button, define server-side JavaScript that returns the name of the page to be loaded. Define a navigation rule in the XPages properties for each value. 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 99 

Gwen would like to display the value of the approval list that uses an encryption key for access. 

How can she go about doing this task? 

A. Use the encryption display control and on the All Properties tab, set the value of Security Options to prompt for SSL Client Certificate. 

B. There is currently no support for encrypted fields in XPages. 

C. Use the encryption display control and on the All Properties tab set the value of Security Options to Enabled encryption for this field. 

D. Make sure that the user’s SSL client certificate is added to the list of encryption keys to be used to view the fields contents. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 100 

Jean wants to provide access to all documents for the people designated as Administrators in her Web application. She needs to be able to add or remove people from this access level easily. Jean currently has an Author Names field named 

Allowed Authors on her forms. 

How should Jean modify her application to meet these requirements? 

A. Create a role in the database’s ACL called Admin and assign the individuals to the role. Place the Admin role into the Allowed Authors field on the form. 
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B. Write an agent to add user names to the Allowed Authors field for selected documents. 

C. Roles are not available for Web users, so Jean needs to give all Administrators a Lotus Notes client. 

D. Create an Administrator ID and add the Administrator ID name to the Allowed Authors field. Have all Administrators use that Administrator ID to access the application 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 101 Which option best describes the benefits of 

being Ajax-enabled? 

A. Content and code can be lode when required, rather than when the page is initially displayed. 

B. You do not need to use agents to interact with the server dynamically. 

C. Ajax functionality can be implemented with much less coding than a traditional Lotus Domino web applicationD. All of the above 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 102 

Dudley is looking to improve the performance on an XPages application he built for the marketing department. This application is not used by a large amount of users at one time. 

Which server page persistence setting would work best in this scenario? 

A. Keep pages in memory 

B. Server default 

C. Keep pages on disk 

D. Keep only the current page on disk 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 103 

Melissa is modifying her Lotus Notes application to use XPages and wants to reuse the forms that they have already, because there are lots of validations done on the fields. 

How can she use the existing form logic in the XPage? 

A. Using the Run Form Validation options, she can set all of the form logic to be triggered operations for on document load, on document save, or both. 

B. There is no need t worry because the form logic that is already in the form is automatically used anyway, because the XPage is bound to the form. 

C. Using the Run Form Validation options, she can set all of the form logic to be triggered operations for on document load or on document save only. 

D. There is no way to reuse that form logic that is already in the form, so it must all be rewritten into the XPage. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 
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QUESTION 104 Maya is considering migrating her existing car rental 

application to use XPages. 

Which of the following sentences is true? 

A. If the existing application is using subforms, the migration is easy: Subforms can be included into XPages without adaptation. 

B. Framesets do not need any rework when migrated to XPages. 

C. Migrating an existing application is hard work, because it is not possible to run an application to run an application that uses XPages and classical design at the same time. 

D. One can use views in XPages. They can be embedded into XPages by using appropriate controls. 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 105 

Mike developed a billing application that should be used with the browser and with XPages. He tested his application locally until it was finished and ready to be deployed to the server. After installing the application on the server, Mike is 

testing the application again. But he is not able to even invoke the application. In the browser, he gets the message Error 403, HTTP Web Server. You are forbidden to perform this operation. 

What could be the reason for this error message? 

A. An administrator must check and unlock Mike’s application first. 

B. Mike needs to open the application properties and click the Server tab. In the Security section, he needs to activate the Application is allowed to run in server option. In addition, he needs to enter the name of the server into 

theAdministration Server field on the same tab. 

C. Mike needs to wait about an hour after deploying the application to the server until the server has cleared all access rights. 

D. Because the application is signed with Mike’s user name and his name does not show in the following entry in the Lotus Domino Server document: On the Security tab, inside the Programmability restriction section the field labeled: 

Signagents or XPages to run on behalf of the invoker. The application needs to be signed with an ID that has rights to run agents or XPages on the server. 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 106 

With server-to-server replication, what is the minimal access level, that a server must have to an application to replicate not only documents, but also design elements? 

A. Reader 

B. Manager 

C. Server always replicate any document independent of their access rights. 

D. Designer 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 107 

When Sydney opens a form or view, he would like it if the outline view would minimize automatically to give more room to the design element list. 

Can this task be done? 

A. Yes, all you need to do when you open a form or a view is to minimize the outline view and click File > Save Designer State 

B. Yes, you need to go into Lotus Domino Designer preferences. Under Eclipse Behavior, make sure that Minimize the Eclipse view selected below is selected and also make sure that Outline is selected. 
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C. Yes, you need to go into Lotus Domino Designer preferences. Under Views & Perspectives, make sure that Minimize the Eclipse vie. 

D. No, you must manually minimize the outline view every time you open a form or view. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 108 Andrew needs to add a tabbed 

interface to his XPage. 

Where does he find a control to enable that functionality? 

A. Core controls 

B. Theme controls 

C. Custom controls 

D. Container controls 

Correct Answer: D 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 109 

Miriam tries to access a hidden control programmatically by client-side JavaScript. When the page is rendered, she cannot access the data of that control. 

Which option might be the reason for this result? 

A. She used a <div style=”display:none”> tag to hide the control. 

B. She deselected the visible property. 

C. She tried to access the data in a custom control, but custom controls do not support JavaScript. 

D. She has set the calculate property to false. 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 110 Rhiannon needs to add a field on her XPage that shows three data options and only one of the options 

can be selected. 

What type of core control does Rhiannon need to use to accomplish this task? 

A. Dialog box 

B. Check box 

C. Radio button 

D. Select button 

Correct Answer: C 

Section: (none) 
Explanation 
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Explanation/Reference: 

QUESTION 111 Frederick has added a button to his XPage 

and labelled it Edit. 

What should he do to make the button put the document in edit mode? 

A. Add a simple action to the button’s onclick event and select the Change Document Mode Action, specifying Edit as the mode. 

B. Add a simple action to the button’s onclick event and select the Edit Document Action. 

C. Add client-side JavaScript to the button’s onclick event and use the @Function script library to execute @Command[(EditDocument)]. 

D. Add server-side JavaScript to the button’s onclick event and use the @Function script library to execute @Command[(EditDocument)]. 

Correct Answer: A 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 112 Zachary is creating a new 

theme for his XPage. 

How is the theme file coded in the Resources area of the application? 

A. CSS 

B. JavaScript 

C. XML 

D. HTML 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 113 

Melanie wants to provide an XPage interface for specific devices. What server-side JavaScript function enables her to identify what type of device is opening her page? 

A. facesContext.getExternalContext().getRequest().getHeader(“User-Agent”) 

B. facesContext.getExternalContext().getRequest().getHeader(“User-Device”) 

C. facesContext.getExternalContext().getContext().getHeader(“User-Device”) 

D. facesContext.getExternalContext().getRequest().getHeader(“User-Agent”) 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 114 

In his XPage stock application, Michael needs the ability, to view and update the properties of goods at several places within the application. Hence, he has developed a custom control for viewing or editing items. Now he wants to select the 

users that are allowed to change the entries. 

How can he achieve this task? 

A. To get that functionality, Michael has to define a second custom control, which encapsulates just the access functionality. Then, he has to group together both custom controls and put this group into the main XPage. 

B. Michael can define the groups or people with different access with the ACL that is associated with a custom control. 
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C. With XPages, there is no specific access control functionality. Michael has to use the Application ACL to control access. 

D. With custom controls, access is not controllable individually. Michael has to do it at the XPages level. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 115 

Carol wants to use the preview in browser functionality while developing an XPage. Before she can use this functionality, she needs to change the ACL of the application. 

Which of the following statements is true regarding this scenario? 

A. It is not true that you have to change the ACL. Web Browser Preview is always working independently of the entries in the application ACL. 

B. Either “-Default-“ or “Anonymous” must have at least Author access. 

C. She has to enter an entry with the name Web Preview Access and give this entry at least Developer access. 

D. her Lotus Notes name must be in the ACL and have Manager access. 

Correct Answer: B 

Section: (none) 
Explanation 

Explanation/Reference: 

QUESTION 116 

Chuck has developed a new XPage application, which is publishing the lunch list of the internal restaurant for each day of the week. When Chuck was testing his application on his local computer, everything was working well, but after 

deploying the application to the intranet server, people are not able to use the application. 

What could be the reason for this problem? 

A. XPages applications developed locally cannot be deployed on a server. 

B. Before task on the Server-Tasks tab of the Server document and by activating the XSP protocol on the Internet-Protocol Tab. 

C. Chuck has forgotten to put his name into the relevant security fields in the Server document or to sign the application with an authorized development ID. 

D. Before Chuck can deploy an XPage application on a server, he must recompile it in designer using Tools > Recompile XPages. 

Correct Answer: C 

Section: (none) 
Explanation 

Explanation/Reference: 
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